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An Overview of the Manual 
 

his manual was written to be used by academics, IT specialists, researchers and librarians to 
train all graduate students at the University of Ibadan in three areas namely: online literature 
searching, reference management and the use of Turnitin to assess plagiarism. 

 
The manual has three sections. The first section is an introduction to Mendeley. The main objective 
of this section is to teach students how to build a Mendeley library and cite while writing. The 
second section focused on literature searching using online academic databases and how to assess 
results from database searches. 
 
The last section will help users of the manual to make submissions to Turnitin, understand and 
interpret reports generated from the web-based resource. Each section has exercises to deepen users’ 
knowledge of the three highlighted areas. 
 
To use the manual, users will require a computer system with Internet access, Mendeley installation 
on the computer system and access to the Turnitin web portal. 
 
The manual is intended to provide a brief introduction to the use of Mendeley, Turnitin and online 
literature searching. It should not be regarded as exhaustive. 

T 
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Section One 
 

1.0 An Introduction to Mendeley 
The objective of this section is to teach users of this manual how to: 

 set up Mendeley on a computer system; 

 build a Mendeley library; 

 create citations in Microsoft Word using Mendeley; and 

 change bibliographic output style in Mendeley. 
 

1.1 An Overview of Mendeley 
Mendeley is a reference management software owned by Elsevier, a renowned publishing company. 
It is a free web-based resource that allows users to: 

 store all the references downloaded from the Internet during research work; 

 import citations from online academic databases; 

 store PDF (Portable Document Format)files, pictures, graphs, tables, etc.; 

 add citations to a term paper, report, journal manuscripts etc.; 

 create bibliographies in any output style; 

 highlight papers and share those comments/notes with others; and 

 it can also serve as an alternative search engine to Research gate, Google Scholar, 
Web of Science and Scopus. 

 
Mendeley has a desktop version and an online version that synchronizes users’ literature searches 
from all over the world and on any device while ensuring the library is continually updated. The 
three versions of the reference management software are Mendeley: Web, Desktop and Mobile. This 
manual will focus on Mendeley Desktop. 
 
Note: Mendeley is preferred to Zotero because of its user- friendly nature and features. 
 
1.2 Setting up Mendeley on a Computer System 
 

1. To install Mendeley on a computer system, it is important to first set up an account on the 
Mendeley website. Visit https:// www. Mendeley. com/ to create your Mendeley account. 

2. After creating a Mendeley account you should be able to download Mendeley Desktop or 
visit http://www.mendeley.com/download-mendeley-desktop/ and click “Download 
Mendeley Desktop” for Windows, Mac OS (Operating system) or Linux System (See Diagram 1). 
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Diagram 1: Downloading Mendeley Desktop for Windows 
 

3. Locate the Mendeley installation file in the download folder and double click on it to set up 
Mendeley on your computer system. 

4. After completing the installation, launch the software by double-clicking on the Mendeley 
icon on the desktop or start-up menu.  

Mendeley icon    
 
The Mendeley interface presented in Diagram 2will be opened once the reference manager has 
finished loading. 
 
1.3 The Mendeley Interface 
 
As shown in Diagram 2, Mendeley Desktop has a three-column view. The first column allows users 
to move through the library, from one folder to the other with many filters. The first column allows 
users to create custom filters for different folders which will also be listed in this column. 
 
The second column provides a list of references, with their details. Entry details – such as a paper 
title, author and year of publication - are displayed in column two. For example, using a view filter 
‘Unsorted’- selected in column one - only the relevant documents will be displayed in column two 
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i.e. the unsorted entries only. If a user selects ‘All Documents’, the main column, column two will 
always display all the entries in the library.  
 
The third column displays all the details of the currently selected reference. The third column is used 
to ensure that a reference’s details have been entered correctly. Clicking on an entry field in the third 
column allows details of the entry to be modified or edited. 
 

 
 
 
 
 
Column One             Column Two                         Column Three 
 
Diagram 2: The Mendeley Interface 
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1.4 Building a Mendeley Library 
 
Before building a Mendeley library, it is important to install the web importer. The web importer is a 
feature in Mendeley that imports references from different online academic databases like from 
Google Scholar, Medline, Web of Science, Scopus etc. 
 
To install the web importer after launching Mendeley, click on ‘Tools’ and select  ‘Install Web 
Importer’ as shown in Diagram 3. 
 

 
 

Diagram 3: Installing Web Importer 
 

For more information on how to install the Web Importer when setting up Mendeley on other 
platforms (like Mac or Linux operating system), See http://www.mendeley.com/download-
mendeley-desktop/ 
 

Building a Mendeley library requires adding references. There are several ways of adding references 
to a Mendeley library: 

i. An easy way to add a reference (such as a PDF file) to a Mendeley library is to drag and drop 
it into the main window of the Mendeley interface. To drag and drop previously saved PDF 
files into a Mendeley library; 
- open the folder containing the files; and 
- drag the pdf file from the folder and drop it into Column two (middle pane) of the 

Mendeley interface. 
ii. Single files can also be added to a Mendeley library using the ‘Add Files’ command, listed 

under the File menu. 
- Click on the File menu and select the ‘Add Files’ command to browse the computer for a 

specific file. 
- Add the file to the library by double-clicking on it. 

iii. A folder containing multiple PDF files can be added using the ‘Add Folder’ listed under the 
File menu.  
- Click on the File menu and select the ‘Add Folder’ command to browse the computer for 

a specific folder. 
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- Add files in the folder by selecting the folder then click ‘OK’. 
iv. References can also be added manually using the ‘Add Entry Manually’ listed under the File 

menu. The command opens a window that allows users to type in the reference type, and to 
input the documents details. 

v. The ‘Watch Folder’ command listed under the File menu can be used to build a Mendeley 
library. The command allows a user to specify a folder on the computer system that will be 
monitored by Mendeley. When a user downloads a new file into the Watch Folder, the new 
file (references) will be routinely imported into the Mendeley library.  

vi. References can be imported directly from online academic databases. Visit the websites 
below for more information : 

https://library.itc.utwente.nl/papers/mendeley.pdf 
 
https://library.technion.ac.il/he/Documents/Mendeley/MENDELEY%20USING%20G
UIDE.pdf 

vii. References can be added to a Mendeley library by importing entries from other reference 
managers like Endnote, Zotero, RefWorks and other libraries in.ris or BibTeX formats. 

 
1.5 Create Citations in Microsoft Word using Mendeley 
 
Before using Mendeley to cite while you write in Microsoft Word, ensure the Word Plugin is 
installed. To install the Word plugin in Mendeley: 

- close the Microsoft Word application if it is open; and 
- select ‘Tools’ on the Mendeley menu and click on ‘Install MS Word Plugin’ command. 

 
To confirm that MS Word Plugin has been installed: 

- launch Microsoft Word; 
- select the ‘Reference’ tab; and 
- if the plugin is installed, you will see the highlighted icon in Diagram 4. 

 
  

Diagram 4: The Insert Citation Tab in Microsoft Word 
 
1. To insert citations into a document when writing using Microsoft Word; 

- select the reference tab in Microsoft Word; 
- click insert citation; 
- use the search bar that opens to find the reference type you want to insert into the document. 

You can search for a reference by typing the author’s name or a title into the search bar; and 
- insert the reference into the document by clicking OK in the Mendeley search bar. 

2.  Alternatively from the Word ‘References’ tab: 
- click insert citation; 
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- on the search bar click the ‘Go to Mendeley’ button; 
- select a reference to highlight in the Mendeley library reference list; and 
- on the menu bar click the “Cite” button to insert the selected reference in the Word 

document. See Diagram 5. 

 
 
Diagram 5: Inserting Citations into a document 

 
2. Adding References to a document 
 
When writing a document using Mendeley, the reference manager will only add the citation without 
references to the document. To add the list of references to a document: 

 position the cursor in the Word document at the exact location where the reference list 
should appear; 

 click on ‘Insert Bibliography’ on the ‘References’ tab. The reference list will be displayed as 
shown in Diagram 6;and 

 subsequently, Mendeley will add citations and references simultaneously in the document. 
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Diagram 6:  Inserting a Bibliography or Reference list into a document 
 
1.6 Changing bibliographic output style in Mendeley 

 
To change the bibliographic output style in Mendeley: 
- select the ‘View’ tab; 
- click on ‘Citation Style’; and 
- choose a bibliographic output style from the dropdown list. 

 In Microsoft Word, under the ‘Reference’ tab, go to ‘Style’ and select the preferred style from the 
dropdown list. 
 

1.7 Adding the University of Ibadan Manual of Style to Mendeley (UIMS) 
 

The UIMS is unique; it is not included in Mendeley output styles by default. To download the 
citation link into Mendeley, follow the steps presented in diagrams 7 to 10. 
 
1. Open “Mendeley Desktop”. 
2. Under “View”, go to “Citation Style” and click on “More Styles”. 
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Diagram 7: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley I 
 
3. A new window will open. Click on “Get more Styles”. 
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Diagram 8: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley II 
 

4. Another window “Get More Styles” will open up. 
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Diagram 9: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley III 
 

5. Type in the University of Ibadan Manual of Style (UIMS) 
link:http://csl.mendeley.com/styles/96716661/unibadanManualofStyle-1 into the “Download Style” 
bar. 
(The UIMS link was generated by Olayinka Fatoki and EriifeOluwa Mofoluwawo in 2006)    
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Diagram 10: Adding the University of Ibadan Manual of Style (UIMS) to Mendeley IV 
 

6. Click on “Download” and then “Done”. 
The University of Ibadan Style will appear in the list of Citation Styles in your Mendeley Desktop. 

 

Exercise 
1. Build a Mendeley library by importing references directly from the following online databases 

into a Mendeley library. 
i. Medline 
ii. Web of Science 
iii. Google Scholar 

 

2. Create a ‘Watch Folder’ on your computer system and use the folder to build your Mendeley 
library. 
 

3. Add the following reference type into your Mendeley library manually: 
i. Book 
ii. Journal article 
iii. Thesis 
iv. Newspaper 
v. Report 
vi. Web page 
vii. Television broadcast 
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Section Two 

 
2.0 Searching Online Academic Databases 
 
This section will guide students and researchers how to search online academic databases in the 
field of population and public health. 
The objectives of the section are to: 

 introduce students to relevant online academic databases available in population and public 
health; 

 teach students basic strategies for searching online academic databases;  and 
 teach students how to access online academic databases to ensure publications that will be 

retrieved from searches are relevant and trustworthy. 
 
2.1 What is an online academic database? 
 
A collection of journals, books, newspapers, etc. produced and published on the Internet by 
publishers in collaboration with academics. Examples are: 

• Medline/Pubmed 
• Popline 
• WHO Global Health Library  
• Global Health (CABI) 
• PsycINFO 
• Web of Science (Multidisciplinary) 
• Scopus (Multidisciplinary) 
• Embase etc. 

 
See Table 1 for the list of online academic databases in population and public health. 
 
Table 1: List of Databases in Population and Public Health 

 
S/N Name of Database Description 

1 PubMed 
https://www.ncbi.nlm.nih.
gov/pubmed/ 

PubMed is a search service owned by the National Library of 
Medicine. It provides access to millions of MEDLINE citations and 
articles up to1960. The database index journals in life sciences. It 
allows users to access abstracts and full-text articles on journal sites 
and other relevant resources. 
 

2 CINAHL 
https://health.ebsco.com/p
roducts/the-cinahl-database 

CINAHL is a vital resource containing information resources 
focusing on nursing and other allied health disciplines. 
 
 

3 EMBASE 

https://www.elsevier.com/solutio
ns/embase-biomedical-research 

EMBASE is a biomedical abstract and indexing service with 
extensive coverage in pharmaceutical research, it is a good 
supplement to PubMed. 
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4 Cochrane Library 

https://www.cochranelibrar
y.com/or 
https://nigeria.cochrane.org/ 

 

Cochrane Library contains databases that provide robust evidence 
on which clinical treatment decisions can be based. Its components 
are Cochrane Reviews (Cochrane Database of Systematic Reviews), 
Database of Abstracts of Reviews of Effects, Cochrane Central 
Register of Controlled Trials, Cochrane Methodology Register, 
Health Technology Assessment Database (HTA), National Health 
Service (NHS), Economic Evaluation Database and  Cochrane 
Groups (the Cochrane Collaboration). 

   
5 Popline 

https://www.popline.org/ 
Popline is a public health database supported by USAID. It contains 
scholarly and non-scholarly literature on family planning, 
population and reproductive health. 
 

6 TOXNET 
https://toxnet.nlm.nih.gov/ 

TOXNET is a collection of databases containing resources on 
toxicology, hazardous chemicals, and biohazards. 
 

7 Trip Pro 
https://www.trippro.com/
tour.html 
 

Trip is a search service designed to find high-quality research 
evidence to support clinical practice and care (Evidence- based 
medicine). The search engine can search concurrently evidence-
based sources of systematic reviews, MEDLINE Clinical Queries. 
 

8 Web of Science 
https://www.webofknowle
dge.com/ 
https://www.webofknowle
dge.com/ 
 

Web of Science is owned by the Institute for Scientific Information 
(ISI) a division of Thomson Reuters which index current and 
retrospective multidisciplinary information resources from 1975 
upwards. It contains bibliographic records from over 8,500 high 
impact research journals.  

9 ERIC on EBSCO host 
https://www.ebsco.com/p
roducts/research-
databases/eric 

The database is the world's largest education database. It can be used 
to search for resources on topics in public health that overlaps into 
the education discipline, including topics like health outreach to 
college students, substance abuse amongst adolescents in secondary 
or high school etc. 
 

10 Psyc INFO 
 
https://www.apa.org/pubs/da
tabases/psycinfo 
 

Psyc INFO was produced by the American Psychological 
Association. It contains resources covering the field of psychology 
and the psychological aspects of related disciplines, like medicine, 
psychiatry, nursing, sociology, education, pharmacology, 
physiology, linguistics, anthropology, business, and law. It is a good 
database for topics on human behaviours, attitudes, or motivations 
on specific public health concerns.  
 

11 Sociological Abstracts (SA) SA is a database containing information resources covering 
sociology as well as related disciplines in the social and behavioural 
sciences. 
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12 PLOS 
https://www.plos.org/ 

PLOS provides access to an open access service containing materials 
in science and medicine. 
 

13 WHO Library 
https://www.who.int/home 
or 
http://kohahq.searo.who.int/ 

The database provides access to bibliographic details and full text of  
WHO publications, technical documents, governing body 
documents, books and reports of NGOs and government agencies 
and list of periodicals on different health issues around the world 
especially developing countries. 

 
See the Appendix for a comprehensive list of electronic resources available through the Kenneth 
Dike Library. 
 
2.2 Using controlled language to search online academic databases 
 
To search an online database, it is important to have a topic of interest or research question. 

1. First, decide on a topic of interest or research question. 
2. Break the topic or research questions into keywords, phrases (search string), synonyms and 

alternative spellings. For example, using the title in Figure 1. 
 
Adolescent Mental Health in Nigeria 
 
 
 
 
 
 
 
 
 
 
Figure 1: Identifying keywords in a research topic 
 
3. Generate synonyms and alternative spellings (See Table 2). 
 
Table 2: Synonyms for the three Keywords 
 

Keyword 1 
Adolescent 

Keyword 2 
Mental Health 

Keyword 3 
Nigeria 

Teen*(Teens,  Teenagers) Mental*(Mental balance, 
Mental soundness, Mental 
condition, Mental state) 

Nigeria 

Young*(Young people/person, 
youngsters, young adults etc.) 

Sanity Nigeria 

Youth Psychological condition Nigeria 
Juvenile Emotional health or 

Intellectual wellbeing 
Nigeria 

 

The topic has 

three key 

words 
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N.B: Truncating the words with the symbol $ or * will allow the database to capture all relevant 
material. E.g. “Teen*” will pick up all documents with teens and teenagers. 
 

4.  Using the Boolean operators OR, AND or NOT 
 

After identifying the keywords or concept, combine these words using the Boolean operators of OR, 
AND or NOT. 
 
Table 3: How to use Boolean operators 
 
Boolean 
Operators 

Keywords Combination Results 

OR Teen* OR Young* 
 
Using the keywords combination to 
search will retrieve records 
containing either term. 

 
 
Just like the Set Theory in mathematics, the result is like the union 
of two sets. 

AND Teens* AND Mental health 
 
This search string will retrieve 
records containing both search terms. 

 
The intersection of two sets 

NOT Mental health NOT Maternal health 
 
The search string excludes records 
containing the second term (Maternal 
health). Retrieves records containing 
the first term. 

 
 

That is the complement of a set. 

 
5. Selection of relevant academic databases to search 
 
The next step is to select databases that best reflect your subject area or topic of interest. The 
application of criteria such as scope, quality, searchability and user-friendliness can help in 
determining the suitability of an online database for literature searches. 
 
6. Criteria for assessing good academic databases 
 

i. Scope: refers to the years covered by the publications in the database, the type of publications, 
how current are the publications, the relevance of the subject coverage and the suitability of 
the database for a comprehensive search. 

ii. Quality of the database: This refers to the trustworthiness of the content of the database. 
Articles in good academic databases are peer-reviewed scholarly work. 

iii. Searchability: This is the ability of the database to allow controlled vocabulary and citation 
searching. The search facilities of the database should be suitable for the subject of interest. 

iv. User-friendliness:-is the ease of use of the database. Will the database allow searches to be 
refined by date, document type, etc.? Can it link users up with full text?  Can it allow the 
importation of search results from it into a reference manager (Mendeley)? 
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7. Use of search filters 
 
Most online academic databases have search filters which can be used to limit or refine a search. 
Filters such as: 

 language of publication, e.g. English only; 

 publication types, e.g. journal articles, book chapters, magazines, websites etc.; 

 year of publication or year range, e.g. 2010, 2005-2010; 

 age group, e.g. adult, young people, old people; and 

 region or country, e.g. Africa, Europe, Nigeria, Switzerland etc. 
 

2.3 Features of online academic databases 
 
1. Online academic databases are produced with the active involvement of academics. 
 
2. Selection of articles for publication in these databases is based on the objective evaluation of merit, 
either through peer-review or impact factor. 
 
3. Academic databases allow citation searching to identify papers that have cited key references. 
 
4. These databases offer analysis and evaluation of journals and authors through impact factor and 
H-index which adds value to published work and recognition for authors. 
 

5. Another important feature is the citation alerts. It helps authors to know who is citing their 
papers. It is also useful for academic departments for monitoring of research output. It can be used 
as an indicator of departmental research quality. 
 

6. Academic databases allow the use of wild cards and Boolean operators when searching. 
 

2.4 Searching an online academic database 
 

This section will focus on how to search PubMed Central through HINARI to apply the search 
strategies in Section 2.3. Start searching PubMed Central via HINARI. 
 

Step 1: Login to HINARI using your institution’s password via https://www.who.int/hinari/en/ 
(See your librarian for HINARI’s login details). 
 



An Introduction to Reference Management and Plagiarism Checker 

17 

 
 

 
  

Figure 2: Logging into HINARI 
 

Step 2: After logging into HINARI, select a free collection and click on PubMed Central (PMC). See 
Figure 3. 

 
 

Figure 3: Select PubMed Central 
NB: Medline is the NIH database (backend), while PubMed is the search engine (frontend). 

 

Step 3: On the PMC interface, type in the keywords of interest in the search box as shown in Figure 
4.For example, let’s use the keywords Teen*, Mental health and Nigeria. 
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Figure 4: Type the keywords in the search box 
 
Searching PubMed Central (PMC) with the keywords Teen*, Mental health, Nigeria using the 
Boolean operator ‘‘AND” gives the result shown in the interface in Figure 5. PMC retrieved over 
8000 journal articles from the journal list. The articles retrieved contain the keywords used for 
searching the list. 
 
Step 4: To further screen the articles retrieved, filters on the left side of the interface can be used for 
screening the results. The results can be screened by attributes such as the type of article, year of 
publication or research funder. 

 

 
 

Figure 5: Highlighting filters on the PMC interface 
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Using the three filters, open access, 5years and NIH reduced the search results to 405 articles. The 
search will return articles published within the last 5years, funded by NIH and under the open 
access license, see Figure 6. 

  

                 
 
 

                   
 

Figure 6: Search results after applying three filters (open access, 5years and NIH) 
 

The basic strategy used for searching PubMed Central can also be used for other online academic 
databases. See Diagram 7 for search results from Cochrane Library using a similar search string. 

 

 
 

Click on the 
title of the 
article to 

access the 
abstract or 
full text. 
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Filters in Cochrane database for refining searches 
 

Figure 7: Search results from the Cochrane Library 
Exercise 
1. Use the keywords identified in Figure 1 (on page 13) to search the following databases: 

i. WHO Library 
ii. PopLine 
iii. PLOS 
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Section Three 

3.0 An introduction to Turnitin 
 
The objective of this section is to teach users of the manual how to: 

 create a class in Turnitin; 

 add assignments to your class; 

 add students to a class; 

 submit assignments from student homepage; 

 view students’ submission; and 

 interpret Turnitin reports. 
 
3.1 An overview of Turnitin 
 
Turnitin is a cloud-based tool that helps students and instructors guide against plagiarism and 
similar research misconduct. Submitted works are compared with a vast library of databases from 
the web, journals, periodicals, academic institutions and a standard repository of previously 
submitted papers to Turnitin.  The software thereafter generates a similarity report which identifies 
amongst many things the sections of the submitted work that matches another text source in the 
databases searched. A list of the matching databases, the overall similarity of the submitted work 
with existing databases, the top databases that have the closest match to the submitted work are also 
included.  To reduce the overall similarity, all instances of a match in the submitted document 
should be rephrased.  
 
Turnitin is not punitive but aims to develop in its users an appreciation for original scholarly work 
as well as the skills that are necessary for paraphrasing and reporting of academic contents. 
 
This manual is divided into two parts; the first titled Instructors’ Setting that describes how 
instructors/teachers will create a class and a second titled Students’ Instructions that details how 
students can make submissions. 
 
3.2 Instructor’s Settings 

To begin, instructors need to register with Turnitin and create a user profile using their institutional 
e-mail address (for example, ab.cdefg@ui.edu.ng). Students do not need Turnitin subscription but 
must first be invited by an instructor to join a class.   
 
3.2.1 Creating a class 
Instructors can create a new class by following the steps below: 

1. When you have successfully logged in, you will be taken to your homepage, also known as 
the instructor’s homepage (See Figure 8). The instructor’s home page amongst other things 
contains tabs which can show all the classes you have created (if there are any), certain setting 
preferences such as the language, help etc. 
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Figure 8: An instructor homepage showing four active classes  
 

2. To create a class, click on the ‘add class’ button to the right of the page. 
3. This will open a set of text fields with which you can specify the required class settings. 
4. Type in the class name of your choice (e.g. GES 301) and an enrolment key will be sent to 

your students for them to join the class. The enrolment key could be as simple as ‘abcd’. 
5. Select the appropriate subject area and student level from the drop-down menu. 
6. Specify the class end date after which the class will become inactive. 
7. Click submit to create a class and add it to your instructor home page. 
8. If you would like students to enrol themselves in this class, they will need both the enrolment 

key you have chosen and the unique class ID generated by Turnitin. 
 
3.2.2 Adding assignments to your class 
Instructors can add various assignments to an existing class by following the steps below. 

1. Enter a class by clicking on the class name as listed on your instructor homepage. 
2. This will take you to that class homepage 
3. Before you or your students can submit any paper, you will need to add an assignment to this 

class. 
4. Click on the ‘add assignment’ tab. 
5. This will open a set of text fields with which you can specify the name of the assignment you 

are creating (e.g. Feasibility Studies), the dates (and time) students can start sending in their 
papers and the deadline for submission. 

6. Under the optional settings tab, you can provide any additional information to the students as 
regards the assignment. See the interface in Figure 9 for details on the Postgraduate College 
settings for thesis plagiarism check. 
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Figure 9: The Postgraduate College settings for thesis plagiarism check 
 

7 The instructor can also specify if students can still turn in their assignments after the due 
date, obtain similarity reports for submissions etc.  

8 In addition, the instructor can specify if quotes, bibliographic materials in students’ 
submissions will be included in the plagiarism check 

9 More importantly, there is a need to indicate if the submissions will be deposited into a 
repository or not. Turnitin maintains a standard repository of previously submitted 
documents, against which subsequent submissions will be checked for similarity. 
Consequently, documents that are work in progress such as draft thesis, manuscripts under 
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review etc. should not be deposited into the repository. It is only finished documents such as 
accepted manuscripts, final thesis copy that should be submitted to the standard repository.  

10 Click submit to create the assignment and add it to the class homepage. 
11 To add students or view your students list, click the "students" tab above. 

 

3.2.3 Adding students to a class 
For students to make submissions to the assignment homepage, the students have to enrol 
themselves by using the class ID and enrolment key provided by the instructor. 
 

Alternatively, the instructor can add students to the class by following the details below:  
1. Click on the ‘students’ tab at the top of the class homepage.  
2. You can enrol students to the class by three different methods which can be assessed by the 

tabs labelled ‘add student’; ‘upload students list’ and ‘e-mail all students”.  
 

Method A 
3. If you click on ‘’add student”, a set of text fields will be displayed showing the name of the 

class the students would be invited to join. 
4. Indicate the first name, last name and valid e-mail address of the student. 
5. Click on submit to add the student to the class. 
6. Repeat steps 1-3 above to add other students as required. 

 
Method B 

7. By clicking on the ‘upload students list’ tab, all the students can be added at once by 
uploading a file that contains the students’ details 

8. The file could be a Plain text, Microsoft Excel or word document and should contain the 
students’ details in the following order: student’s first name, last name and e-mail address. 

9. A properly formatted MS Excel list that can be uploaded will appear as shown below: 
 

A B C 

Akin Omoakin aomoakin@yahoo.com 
Nneka Ojie nne@yahoo.com 

 
10. To use this second method, click on the “upload students list” tab, then on the browse tab to 

locate the students’ details file and then click on upload list to add the students to the class. 
 
Method C 

11. Thirdly, you can email all the students to join the class. 
 
Whichever method is utilized, students who have a Turnitin subscription will be automatically 
added while an e-mail containing a link to join the class will be sent to all the invited students who 
do not have Turnitin subscription.  
 
3.2.4 Viewing students’ submission 

1. From your instructor homepage, select a class by clicking on the class name. 
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2. The class homepage shown in Figure 10 displays a list of the assignments, the start and end 
dates and an indication of how many students have turned in their submission for each 
assignment. 

3. Click on the “view” link to view the students’ submission for each assignment. This will 
display a list of all the students enrolled in the class, those who have submitted, their 
submissions, date submitted and the similarity report for each student’s submission. 

4. To view the report for each student, click on the Similarity Report icon in the similarity column 
which can be found to the immediate right of the paper’s name. A ghosted icon indicates that 
the Similarity Report has not yet been generated. 
 

           
 
Figure 10: An assignment inbox showing the submissions of three students 
 
3.3 Students’ Instructions 
3.3.1 Joining a class and setting up a student’s account 
Students can join a class by following the steps below: 

1. After you have been invited by an instructor, you will receive an e-mail containing the 
names of the classes you have been invited to join and the instructors who invited you. 

2. Click on the “set up account” link in the e-mail. This will take you to the Turnitin account set 
up page. 

3. Input your email address and surname in the appropriate fields and click on the “next” 
button. 

4. To validate your account, a link will be sent to the e-mail address you have just provided. 
5. Open the message in your inbox and click on the “create password”. This must be done 

within 24 hours before the link expires. 
6. Clicking on the link will take you to a page where you can provide a password of your 

choice. The password must be a minimum of eight characters. Click on “create password” 
after filling the text fields.  
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7. You will be notified that account set up is complete. 
8. Click on the “Log in” button to take you to your student homepage. 

 
9. Your student homepage will show you the classes you are enrolled in. 
10. To enrol in a new class, click on the “enrol in a class” tab at the top of your homepage. 

 
3.3.2 Submitting a paper from your student homepage 

1. Click on the appropriate class name. This will take you to the class homepage where you can 
see all the assignments for this class. 

2. To submit an assignment, click on the “submit” button to the right of the assignment name. 
 

          
 

Figure 11: A student class homepage showing two assignments; feasibility studies and 
implementation strategies 
 

3. This will take you to a page showing your names, a text field in which you can specify the 
submission title. A drop-down menu just above your first name provides options for single 
file upload and cut & paste.  

4. With the single file upload option, you can upload a file saved on your computer, in Drop 
box or Google drive by clicking on the appropriate link amongst the three. 

5. Click on the “upload” button at the bottom of the page  
6. Wait for a few minutes (depending on the size of the uploaded document) after which a 

preview of the document you are trying to upload will be generated. 
7. Finish the submission by clicking on the “confirm” button at the bottom of the page. 
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8. Your submission will be confirmed and a digital receipt of it will be generated which you 
can print out if you wish. You can return to the assignment inbox or upload another file by 
clicking on the appropriate buttons at the bottom of the page. 
 

3.3.3 Viewing the similarity report for your submission 
 

1. Go to the assignment inbox. This will show a list of submitted papers and their similarity 
reports. 

2. To view the similarity report of a paper, click on the Similarity Report icon in the similarity 
column which can be found to the immediate right of the paper’s name. A ghosted icon 
indicates that the Similarity Report has not yet been generated. 

3. The similarity report will be open in a new browser window called the document viewer. 
See figure 12 for a detailed view of the Turnitin document viewer. 
 

3.4 Interpreting a similarity report 
 

 
 
 
Figure 12: A typical document viewer is reproduced below 

 
1. The document viewer will show the contents of the paper and a sidebar to the right. 
2. Texts of the submitted document that show no variation in exact wording with databases 

(this is called a match) are highlighted, colour-coded and tagged with a match flag. 
3. All the match flags are numbered. Clicking on a match flag will open the database (original 

source).  
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4. The sidebar contains the top sources which are the databases that have the closest match to 
the submitted document text. 

5. The sidebar also contains a match overview-a percentage indication of the overall similarity 
of the paper to databases. To reduce the overall similarity, all instances of a match in the 
submitted document should be rephrased 

6. Click on the “list of all sources” in the side bar to see a list of all matching databases and the 
percentage amount each contributes to the overall similarity of your report. 

7. Click on the “filter and settings” button to exclude quotes, bibliography, sources that are less 
than a specified number of words or percentage. 

8. Click on the download button. It will provide options to download the current view (i.e. a 
PDF file format of the similarity report), digital receipt of the submission or the originally 
submitted file. 

 
 
Exercises 

1. Create a class and enrol 5 students into the class. 
2. How do you view a students’ submission? 
3. Describe the important steps in interpreting a similarity report. 

 
Conclusion 

This manual provides foundational knowledge in online literature searching, reference management 
and the use of Turnitin to assess plagiarism. It was reviewed and tested through workshop sessions 
with librarians and graduate students at the University of Ibadan. There remains a great deal that 
students need to learn to advance their knowledge and skill as this is just an introduction into the 
three areas. Hence, students who need further assistance or personal tutorials can contact the 
Systems Unit at the Kenneth Dike Library, University of Ibadan or the E. Latunde Odeku Medical 
Library, College. 
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Appendix 
List of Available Electronic Resources available through Kenneth Dike Library 

 

4 SPRINGER 
URL:   
link.springer.com 
Access:  IP-
regulated 

Providing researchers with access to millions of scientific 
documents from journals, books, series, protocols and reference 
works. It covers the following subject areas: Architecture & 
Design Astronomy, Biomedical Sciences, Business & 
Management, Chemistry, Computer Science, Earth Sciences & 
Geography, Economics, Education Language, Energy, 
Engineering, Environmental Sciences, Food Science & Nutrition, 
Law, Life, Sciences, Materials, Mathematics, Medicine, 
Philosophy, Physics, Psychology, Public Health, Social Sciences 
and Statistics . 

 

S/No Electronic Resources Remark 
   

1 PROQUEST 
URL: 
search.proquest.com 
Access: IP-regulated 

 

All Subject Areas 

2 EMERALD 
URL:  
http://emeraldinsight.
com 
Access:  IP-regulated 

Contains Journals & Books in the following subject areas: 
Accounting & Finance, Economics, Education, Engineering, 
Health & Social Care, Human Resource & Organizational 
Behaviour, Information & Knowledge Management, Library & 
Information Science, Management Science & Operations, 
Marketing, Property Management & Built Environment, Public 
Policy & Environmental Management, Sociology, Strategy, 
Tourism & Hospitality and Transport. 
 

3 JAYPEE 
URL:  
Jaypeedigital.com 
Access:  IP-regulated 
 

  

EBOOK 
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5 JSTOR 
URL:  
http://www.jstor.org/ 
Access:  IP-
regulated & 
individual 
registration 
required 

A journal store with resources on ALL subjects. This resource is 
IP regulated on campus. 0FF campus access is by the token 
method that requires registration. Follow the link provided from 
a computer on a UI Net, and a user’s name and password could 
be created for individuals which can then be used off- campus 
consequently. 
 

6 IMF E-Library 
URL:www.elibrary.
imf.org/searchIP-
regulated 

Business and Economics, Education, Law, Medical, Nature, 
Political Science, Social Science, Technology and Engineering. 

 
7             BIOONE    
              www.bioone.org 

        IP-regulated 
 

 

8 Nature Journals 
www.nature.com 
IP-regulated 
 

Biological Sciences, Earth & Environmental Sciences, Physical 
Sciences and Scientific Community & Society. 

9 New England 
Journal of Medicine 
http://www.nejm.or
g 

IP-regulated 
 

Medical Specialties & Clinical Medicine 

10 Royal Society 
Journals Collection 
http://royalsociety
publishing.org 
IP-regulated 
 

Royal Society Journals Collection is an online, fully open access 
journal. It publishes articles from across the whole of science, 
engineering and mathematics. It operates objective, and 
optionally open, peer review. 

11 DOAJ 
http://www.doaj.org 

Open Access 

This service covers free, full text, quality controlled scientific and 
scholarly journals. There are 2411 journals in the directory. 
Currently, 708 journals are searchable at article level.   
 

12 DOAB 
http://www.doabb
ooks.org 
Open Access 
 

Free access E-Books. 
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13 BOOKBOON 
http://www.bookb
oon.com 
Open Access 
 

Free access E-Book 

14 African Journals 
Online 
http://www.ajol.inf
o/ 
Open Access 

African Journal Online (AJOL) is a service to provide access to 
African published research and increase worldwide knowledge of 
indigenous scholarship.  
 

15 BIOMED CENTRAL 
http://www.biome
dcentral 
Open Access 
 

Biomed central is a publisher of more than 150 peer-reviewed 
open access journals.  

16 BMJ Publishing 
Group 
http://www.bmjjou
rnals.com/subscipti
on/countries.shtml 
Open Access 
 

BMJ Group publishes BMJ (British medical Journal), a number of 
journals covering major medical Specialties and a growing 
number of online and events products for the healthcare 
profession. 

17 POPLINE 
http://www.poplin
e.org   
Open Access 
 

POPLINE®  (Population Information online), the world’s largest 
databases on reproductive health.  

18 Free Pdf 
http://www.freefull
pdf.com 
Open Access 

Covers all subject areas 

 
19 World Bank Group 

www.worldbank.org 

Open Access 
 

 

20 E-JOURNALS 
http://www.e-
journals.org 
Open Access 
 

E-journals are part of the World Wide Virtual library. Provides 
links to world electronic journals. 
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21 INTECH 
http://www.intech
open.com/ 
Open Access 
 

All Subject areas especially Sciences  

22 ERIC 
http://eric.
ed.gov/ 
Open 
Access 

ERIC (Education Resources Information Centre) is a 
comprehensive database containing abstracts of journals articles, 
reports, curriculum guides, conference proceedings, etc. It covers 
all areas of education at all ages and grade levels. ERIC 
Documents 1993+ is now freely available online. 

 
23 SAGE SAGE is a leading international provider of innovative, high-

quality content publishing more than 1000 journals and over 800 
new books each year, spanning a wide range of subject areas. 
 

24 Z-Library 
Open 
Access 

Covers a wide range of subject areas. Users can download 10 
books or more daily. 

 
NB: IP Regulated- implies user must be on the University Network to have access. For further 
enquiries on the e-resources contact, eresources@library.ui.edu.ng 
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